
Introduction to Document Management: Quick Start

The TI-Nspire learning handhelds and 
computer software offer a new experience in 
teaching and learning technologies for the 
mathematics and science classrooms. Using 
these exciting new tools, teachers and 
students will be able to work seamlessly 
across representations, documents, and even 
computer platforms.

It is recommended that you fi rst work through 
the “Getting Started” tutorial so that you can 
become familiar with the management and 
navigation features of the TI-Nspire handheld.

The HOME (c) key at the top right of the 
keypad provides immediate access to the 
main features of the device, including My 
Documents, where documents are organized 
into folders as they would be on a computer.

Press � on the circular NavPad to move down 
to the folder titled “GettingStarted.” Press the 
ENTER (·) key or � on the NavPad to open 
the folder.

Figure 1.1: The Home Screen

Figure 1.2: Opening a Folder
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1. INTRODUCING THE DOCUMENT MODEL

Welcome to an exciting new world for teachers and students of mathematics and science!

In this section, you will be introduced to some of the key features of 
TI-Nspire™ learning technology, including:

1. understanding the structure of the TI-Nspire document model

2. using menus to create and navigate documents

3. using keyboard shortcuts for accessing menus and menu items
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Use the cursor controls and · to locate and 
open the fi le titled “01.Getting Started.”

After opening the document, you will see a
screen very much like the one shown in 
Figure 1.3. Working through this tutorial fi le will 
introduce you to many of the key features that 
defi ne the TI-Nspire document model.

Among these key features are useful and easy 
ways to navigate through documents. For 
example, pressing the CTRL (/) key and � on 
the NavPad will take you to the next page in a
document. Similarly, pressing / � � returns 
you to the previous page. Pressing / � � 
will take you to the Page Sorter. Here, you can 
move quickly and easily through the pages of a 
document. Pressing / � � once more takes 
you to My Documents.

Figure 1.4 shows the information provided in
the Page Sorter view: the name of the 
document (01.GettingStarted.tns), the 
number of the problem that you are currently 
working in (problem 1), and the total number of 
pages in the problem (for problem 1, 2 pages). 

A TI-Nspire document may consist of multiple 
problems (each with their own set of variables) 
and each problem may consist of multiple 
pages. The document as shown in Figure 1.4 
consists of at least two problems, with 2 and 
7 pages, respectively.

From the Page Sorter, pressing / � � 
will return you to single page view, where you 
can fi nd information at the top of the screen 
indicating your location in the document. For 
example, in Figure 1.5, the tab labeled 2.1 is 
highlighted to indicate that you are on page 1
of problem 2. Current system settings are 
shown to the right of the tabs.

Figure 1.5: Keeping Track of Your Progress

Figure 1.4: Page Sorter View

Figure 1.3: A Sample Document
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Each page of a document can contain one or 
more of the core TI-Nspire applications. These 
applications are:

1. Calculator

2. Graphs & Geometry

3. Lists & Spreadsheet

4. Notes

A page can be divided into as many as four work 
areas, allowing up to four different applications 
to be used per page. Figure 1.6 shows a page 
which has the Notes application at the top, and 
the Calculator application at the bottom.

You will learn much more about each of these 
applications and how they work together in the 
tutorials that follow. Although you may leave a 
document at any time, save it, and return to it 
later, you should continue to work through this 
01.GettingStarted.tns document to learn more.

Locate the HOME (c) key at the top right 
corner of the keypad. When pressed, it 
activates the Home screen: an icon-based 
view of common tasks as described below.

Selecting one of the TI-Nspire applications will 
insert that page into your current document. 
For example, selecting 1:Calculator will insert 
a Calculator page.

Pressing 5:New Document will prompt you to
save or discard any changes made to the 
current document before opening a new one, 
while 6:My Documents opens the document 
browser from which an existing document may 
be selected.

8:System Info is available here, and pressing 
9:Hints brings up a summary of shortcuts and 
navigation features as shown in Figure 1.8.

Figure 1.8: Helpful Hints

Figure 1.7: Home Screen Icon desktop

Figure 1.6: A Split Screen
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Return to the Home screen, and select 
6:My Documents to access the document 
browser. (The current document remains 
active until you choose to open another 
document or create a new document, at which 
time you will be prompted to save or discard 
any changes you have made.)

The MENU (b) key, located below the 
HOME key, opens a drop-down menu which 
provides access to management features of 
the document browser as shown in Figure 1.9. 
This MENU key will always provide access to 
the features of the current environment. For 
example, within the Notes application, this 
menu offers only the available options for the 
Notes application.

Press the ESC (d) key at the top left of the 
keypad to close out of a menu or dialog box.

Pressing / � b from the document 
browser accesses a fl oating contextual menu 
with commonly-used features required for 
folder and document management (See 
Figure 1.10). This feature is context-specifi c 
and will offer useful options for the current 
working environment.

More complete document management 
options are available through the TOOLS (#) 
menu. To access the TOOLS menu, press 
/ � c. Within any application, this TOOLS 
menu retains the same features as shown in
Figure 1.11. Most of the options that are 
unavailable within the document browser 
environment (shown in Figure 1.11 as “grayed 
out”) will be active within an application page 
in a document.

Let’s now to begin working with a new 
document and explore our fi rst TI-Nspire 
application.

Figure 1.11: Document Browser—TOOLS
(CTRL � HOME)

Figure 1.10: Document Browser—CTRL � MENU

Figure 1.9: Document Browser—MENU
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2. INTRODUCING THE CALCULATOR APPLICATION

In this section, you will be introduced to some of the key features of the 
TI-Nspire™ Calculator application, including:

1. using templates and the Catalog to create mathematical expressions

2. using menu items to carry out mathematical processes, both numeric and algebraic

3. defi ning functions, variables, and matrices

4. moving between exact and approximate modes of computation

At the heart of TI-Nspire learning technology 
lies the Calculator application, the 
workspace for both numeric operations 
and algebra. Create a new document 
and press · to choose the Calculator 
application. Try recreating the examples 
shown in Figure 2.1. You can either 
directly type the commands or explore 
the menus.

In this section, we will explore some of the 
properties of a most interesting number, the
Golden Ratio, and in doing so, learn more
about the TI-Nspire Calculator application.

Insert a new Calculator page by pressing 
/ � I (the letter I on the small green 
buttons) and then pressing ·. Type “1” 
using the keypad, and press the ENTER key.

Now type “1 �” and press / followed by the 
p key to produce the fraction template. 

Alternatively, the Catalog (k) key or 
/ � b (shown in Figure 2.2) will offer 
access to the templates menu, from which the 
fraction template may be chosen.

Figure 2.1: The Calculator Application
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Figure 2.2: Choosing a Template



Figure 2.5: Accessing Document Settings
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Enter “1” in the numerator position (top of the 
fraction), and then move to the denominator 
position (bottom of the fraction) by pressing � 
on the NavPad or by pressing the TAB (e) 
key—located below the ESC key.

For the denominator, enter “Ans” by pressing 
/ followed by v—the white key to the left 
of the ENTER key. Alternatively, you may type 
“Ans” using the green alphabet keys.

Press · to evaluate the expression.

Pressing · again instructs the device to 
repeat the last instruction—to fi nd the sum 
of 1 and the reciprocal of the last answer.

Repeating this simple activity produces 
a series of fractions which have a very 
particular pattern. Each fraction is made up 
of successive terms of the famous Fibonacci 
Sequence, where each term is the sum of the 
two previous terms:

 1, 1, 2, 3, 5, 8, 13, 21, …

Can you see these numbers emerging in your 
fraction calculations?

Something else is happening as this pattern 
unfolds, but it is not entirely obvious while the 
results are in exact form. Several options are 
available for producing approximate answers.

To change the settings for the entire document, 
press / � c to access the TOOLS menu 
(#), and then press � on the NavPad to 
expand the File menu, as shown in Figure 2.5.
Arrow down to 6:Document Settings (or simply 
press the number 6).

Figure 2.4: Building a Repeated Expression

Figure 2.3: Working with Templates
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Press e to move through the settings until 
the “Auto or Approx.” setting is highlighted. The 
default setting for this is “Auto,” which allows 
the device to choose the most appropriate 
form for an answer. Press � to access the 
different options and select “Approximate.” Then
press e again until the “OK” box is highlighted
and press · to confi rm your choice.

This changes the setting for the document 
and subsequent calculations will remain in this 
mode until it is changed again.

A less permanent option (and the one used in 
this activity) is to press / before pressing 
· to evaluate an expression. This will force 
an approximate result. Alternatively, entering 
any numeral in the expression in decimal 
form (e.g., 1.0 instead of 1) will also force an 
approximation.

Note that after forcing one approximation, 
subsequent calculations remain in approximate 
mode, due to the repeated nature of this 
calculation and since the Ans value is now in 
decimal form.

Continue pressing · to produce a series of 
numbers which appear to converge to a single 
result—the famous Golden Ratio!

If a more or less exact result is required, return 
once more to the Document Settings and 
change the “Display Digits” menu option.

Figure 2.7: From Exact to Approximate

Figure 2.6: Confi guring Document Settings
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Figure 2.8: Decimal Forms



Figure 2.11: Using Numerical Solve

Figure 2.10: Special Properties of “gold”

Figure 2.9: Better and Better Approximations

Interested students may wish to continue the 
computation until the decimal form remains 
unchanged, indicating that they have reached 
the limits of the device’s visible accuracy. 
We say “visible” because, although it will not 
display more than 12 fi gure accuracy, another 
6 decimal places are used to ensure accuracy 
of calculation “behind the scenes”!

The Golden Ratio has many interesting 
properties, both numerical and algebraic. 
Defi ne the last result as a variable, “gold.” 
To do so, type “Defi ne gold �” and press � 
on the NavPad to highlight the last calculated 
answer. Press · to copy the expression to 
the entry line, and press · again to complete 
the defi nition.

Now take the reciprocal of gold. (You may like 
to use the keyboard shortcut for the fraction 
template, introduced earlier!) The result is 
exactly 1 less than gold—the “tail” of the 
decimal form remains unchanged!

Now fi nd the square of gold. (The SQUARE 
(q) key is halfway down the left-hand side 
of the keypad. The CARET (l) key moves 
the cursor into the raised exponent position 
for entering powers and is located above the 
SQUARE key.) The “tail” is again unchanged, 
and the result is exactly 1 more than gold! 

Can you see how both these interesting results 
may be expressed algebraically? Two different 
equations can be written from these results 
and solved as shown in Figure 2.11.

Take some time to explore these interesting 
numbers further—the Fibonacci Sequence and
the Golden Ratio tell us much about nature 
and art, and there is more yet to be discovered! 
Using the powerful features available within 
TI-Nspire learning technology, you have ideal 
tools for such an investigation!
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3. INTRODUCING THE GRAPHS & GEOMETRY APPLICATION

The Graphs & Geometry application is perhaps the most visually exciting of 
the TI-Nspire™ applications. In this activity, you will explore some of the 
functionality of the Graphs & Geometry application, including:

1. plotting function graphs

2. examining the graph as a geometric object

3. constructing tangents, perpendiculars, and loci

4. using templates to enter mathematical expressions

This activity was originally developed by Dr. Charles Vonder Embse from Central Michigan University.

 Getting Started with TI-NspireTM

 3. Introducing the Graphs & Geometry Application

Begin with a new TI-Nspire document, and 
create a Graphs & Geometry page. Throughout 
this activity, you will be pressing b to access 
different tools. While using a tool, its icon will 
appear in the upper left corner of the screen. 
When you have fi nished using a tool, press 
d to close out of it.

From the Points & Lines menu, select the 
Point On tool ( ) to create a point on the 
x-axis, and label this point X. Labeling can be 
achieved by typing the label immediately after 
placing the point, or afterwards by using the 
Coordinates and Equations tool ( ) 
(MENU � Tools � Coordinates and Equations).
(Note: Unless otherwise directed, do not place 
points on tick marks; this will cause them to 
“jump” from mark to mark when dragged, rather
than moving continuously along the axis.)

You may wish to use the Attributes tool ( ) 
(MENU � Tools � Attributes) to change the 
style of the point to increase its visibility.

Next, construct a line through this point that 
is perpendicular to the x-axis using the 
Perpendicular tool ( ) from the Construction 
menu—again you may use the Attributes tool 
to change the appearance of this line.

Figure 3.2: Point On an Axis and Perpendicular

Figure 3.1: Accessing Tools through Menus
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Move the cursor to the Entry Line and press the
CLICK (x) key to activate it. Enter a cubic 
function, such as x3 � 5x � 2 (as shown), press 
· to graph it, and press d to return to the work 
area. Now, grab and drag tick marks on the axes
to gain a better viewing window for this function. 

To grab an object, hover the cursor over it until 
the object pulses—the cursor should resemble 
an open hand (÷). Press and hold the CLICK 
key until the cursor changes to a closed hand 
({). Then simply use the NavPad to move the 
object as desired.

Note that pressing and releasing the SHIFT (g)
key, holding the CLICK key, and then dragging 
allows the axes to be scaled independently. 
You may also grab and drag the end points of 
the axes, or type directly into the values at the 
ends of each axis. Window Settings can also 
be adjusted from the Window menu.

From the Points & Lines menu, select the 
Intersection Point(s) tool ( ) to locate the 
point at which the line and curve intersect. 
Label this point T.

Pressing / � G will hide the Entry Line at
the bottom of the screen to free up some space. 
(Pressing / � G again will bring it back.)

Next, create a dynamic tangent to the curve at 
point T by using the Tangent tool ( ) from the 
Points & Lines menu.

From the Measurement menu, select the 
Slope tool ( ) to measure the slope of the 
tangent line. You may wish to move the slope 
to a convenient place on the screen, such as 
the lower right corner. Because this value will, 
of course, dynamically change as point X is 
dragged, it is benefi cial to have it in a fi xed 
position so you know where to fi nd it.

Figure 3.4: Intersection of Perpendicular and Curve

Figure 3.3: Function Graphing and Adjusting Axes

Figure 3.5: Adding a Dynamic Tangent
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The Measurement Transfer tool ( ), 
available from the Construction menu, allows 
calculated measurements to be transferred 
to lines, segments, rays, and other geometric 
fi gures. Then, as the original fi gure’s 
measurements change, so will the transferred 
measurement. 

Select the Measurement Transfer tool and 
click on the slope measurement as shown 
in Figure 3.6. Then click on the y-axis. This 
creates a point on the y-axis such that the 
distance from the origin to the point is equal to 
the slope of the tangent line!

Press d to close out of the Measurement 
Transfer tool, and use the Perpendicular tool 
to create a perpendicular line to the y-axis that 
passes through this newly constructed point. 
(Again, you may wish to use the Attributes 
tool to change this line’s appearance.) Now 
use the Intersection Point(s) tool to fi nd 
and label point P, the intersection of the two 
constructed perpendicular lines.

As you drag point X along the x-axis, study the 
movement of point P, and try to describe the 
path it takes. Explain what point P represents 
in terms of the constructions.

After some discussion, select the Locus tool 
( ) from the Construction menu. Clicking on 
point P and then on point X will generate the 
path of the set of all points P as the point X is 
moved along the axis. 

Further discussion should center on the nature 
of this new curve, which was derived from the 
original curve by graphing the slope at each 
point of the domain.

Figure 3.8: Locus of the Tangent Slope

Figure 3.7: Intersection of Perpendiculars

Figure 3.6: Measurement Transfer Tool
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Figure 3.10: Stretching a Function

Figure 3.9: Translating a Function

Unhide the Entry Line and enter x2 in for 
f2(x). Grab the graph of this parabola near 
the origin (the cursor should look as shown in 
Figure 3.9: ö) and drag its vertex to match 
that of the derived function you have created 
using the Locus tool. Note that the equation 
updates as the curve is translated.

You may also double-click the function label for 
f2(x) on the graph which opens the function in 
a text box, ready to edit.

Grab one of the arms of the parabola (now the 
cursor should look as shown in Figure 3.10: õ) 
and drag to stretch until it closely matches 
the curve. The equation again updates as the 
curve is stretched. Try adjusting the function 
equation to better match your curve!

After further discussion, the equation of the 
derived function may be recognized as 3x2 � 5.
How might this be found from the original function?

Now, you can alter the equation for f1(x) 
and observe how it affects the graph of the 
derived function. Then attempt to fi nd the 
equation of the derived function by starting 
with a fundamental function and dragging and 
stretching.

Explore and enjoy!
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4. INTRODUCING THE LISTS & SPREADSHEET APPLICATION

The Lists & Spreadsheet application is one of the four core TI-Nspire™ 
applications. In this activity, you will analyze data using the some 
of the functionality of the Lists & Spreadsheet application, including:

1. entering data into lists

2. naming lists

3. using formulas

4. determining regression equations

Scenario

Although airships are still used for 
aviation including advertising blimps 
over sporting events, sightseeing 
rides, and heavy lifting, there are still 
concerns by the public about their 
safety. This is mostly due to the 
historic case of a Zeppelin exploding 
in 1937—known as the Hindenburg 
disaster. Currently a safer gas, helium, 
is used rather than hydrogen gas, 
which was the gas used in the early 
Zeppelin airships. 
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The table below shows how the volume of hydrogen gas affects the pressure when the 
temperature is kept at 27°C.

Volume (liters) Pressure (atm)
1.25 20
0.84 30
0.63 40
0.51 50
0.26 100

It is clear from the above data and our own understanding that if the space (volume) of 
the gas is decreased the pressure will increase. We will investigate the mathematical 
relationship between the pressure and the volume of hydrogen gas.
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Figure 4.2: Entering Data

Figure 4.3: Entering a Formula

Figure 4.1: A New Lists & Spreadsheet Page

Step-by-Step Instructions

Open a new document and insert the Lists & 
Spreadsheet application. From the Actions 
menu, select Resize and press � on the 
NavPad to make each of the fi rst three 
columns wider.

Move the cursor into the heading space of 
Column A and type in volume as the List 
name. Press ·. Type in pressure as the List 
name for Column B. Press ·.

In Column A, enter the volume readings from 
the table on page 17. In Column B, enter the 
pressure readings.

According to Boyle’s Law for an ideal gas, 
pressure varies inversely with volume. 
That is, for a set amount of gas, the lesser 
the volume, the greater the pressure: 
P �   1 _ v  . This means that P �   k _ v   or 
P � V � k (where k is some constant). 

Create a formula in Column C to multiply the 
two lists, volume and pressure, as follows. 
Move the cursor to the formula cell (in gray) in 
Column C and press =. Then press the VAR 
(h) key and Link to the volume variable. 
Insert the multiplication sign (press r) and 
use the VAR key again to Link to the pressure 
variable. Press · to populate the column.
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Does the data support Boyle’s law? (Are the 
values in Column C constant?)

If the data is in fact related by P �   k _ v  , then a 
power regression should show P � kV�1.

To perform a regression, highlight Columns 
A and B by choosing MENU � Actions � 
Select � Select Column, and then hold down 
the SHIFT (g) key and arrow over to select 
both columns. Alternatively, you can move the 
cursor to the top of Column A, press � on the 
NavPad to select Column A, hold down the 
g key, and press � to extend the selection to 
include Column B.

From the Statistics menu, select Stat 
Calculations. Note that there are numerous 
different regressions that may be performed 
on a set of data. For this activity, we wish to 
perform a Power Regression.

Figure 4.6: Performing Statistical Calculations

Figure 4.5: Selecting Columns

Figure 4.4: Interpreting Results
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Note that the Column names a[] and b[] 
are shown rather than the List names. You 
can choose the List names if you prefer by 
pressing � on the NavPad. Press e to 
move down to the “1st Result Column” option. 
Because we have data in Column C, you need 
to direct the regression equation to fi ll Column 
D by changing “c[]” to “d[]”. Notice that the 
options as they are set will save the regression 
equation to f1.

You may wish to resize Columns D and E to
view the results of the regression. The regression 
equation of P � 25.07V �1.03 is quite acceptable 
as an approximation of P � kV �1 and thus the 
data supports Boyle’s Law.

You can plot this data along with the regression 
function in the Graphs & Geometry application. 
Press / � I and insert a new Graphs & 
Geometry page. 

Draw a scatter plot of Volume vs. Pressure 
(MENU � Graph Type � Scatter Plot). 
Press · to choose the x-variable (select 
volume), press e, then press · to choose 
the y-variable (select pressure). Adjust the 
window (MENU � Window � Zoom – Stat), 
and plot the regression equation (MENU � 
Graph Type � Function)—press � on the 
NavPad to access f1(x), and press · to 
draw its graph.

Hydrogen might be close to an “ideal gas” but 
is it ideal for an airship? Figure 4.9: Graphical Results

Figure 4.8: Results of a Power Regression

Figure 4.7: Setting Up a Regression
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5. INTRODUCING THE NOTES APPLICATION

In this section, you will be introduced to some of the key features of the 
TI-Nspire™ Notes application, including:

1. entering and accenting text

2. using templates for Questions/Answers and Proofs

3. using the Symbol Palette to enter mathematical terms

4. evaluating mathematical expressions

A unique feature of this new and exciting tool 
is the TI-Nspire document model. Previously 
when working with handheld devices, users 
would enter and perform calculations, and then 
record results and explanations elsewhere, in 
workbooks or even examination papers.

With TI-Nspire learning technology, the user 
can begin by creating a new document, and 
directly record all work in the same electronic 
fi le, providing a complete documentation 
of their mathematical activities. Using the 
Notes application, problems may be posed 
and solved, reasoning may be recorded, and 
mathematical thinking may be made public!

There are a variety of ways that users can 
format text to accentuate important aspects 
of their documents and to produce text that is 
richly presented. Bold (Keyword), underline 
(Title), and italics (Sub-heading) options 
are available via the Format menu, as are 
superscript and subscript options.

These documents may be readily shared with 
others—teachers or other students, whether 
in handheld or computer-based environments. 
TI-Nspire documents may be transferred 
seamlessly across platforms!

Figure 5.2: Accenting Text

Figure 5.1: Introducing Notes
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The Notes application offers templates for 
presenting and organizing these documents. 
In addition to free-text pages as shown in 
Figure 5.1, users may choose the Q&A format 
as shown in Figure 5.3. This format allows 
teachers (or students) to pose questions, and 
record answers. Of course, these answers may 
be hidden if desired!

The PROOF format is ideally designed, not 
only for geometric proof, but for all manner 
of logical argument. Choosing Shape from 
the Insert menu (or using the Catalog (k) 
key) offers a range of geometric symbols 
which satisfy a long-recognized need for a 
simple and convenient way for entering and 
representing geometric proofs.

This format supports and encourages students 
to make mathematical statements of all kinds, 
and to develop arguments to justify their ideas.

Perhaps the most remarkable feature of this 
apparently simple application is that, like all 
other TI-Nspire working environments, Notes 
is mathematically active!

Mathematical expressions and equations 
may be entered using the Catalog (k) 
key and symbol palette (or simply typed), 
highlighted, and then evaluated using 
MENU � Actions � Evaluate Selection.

Figure 5.5: Mathematically Active Documents

Figure 5.4: Proof Template

Figure 5.3: Q&A Template
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One way in which this powerful feature may 
be used involves entering a mathematical 
expression (as shown in Figure 5.6), 
highlighting, and then copying the expression 
(using the shortcut / � C). This may be 
pasted on the next line (using the shortcut 
/ � V), and then evaluated, displaying 
both input and output for each computation.

Using MENU � Insert � Expression box, 
correct mathematical formatting is available, in 
addition to a range of geometric shapes.

Figure 5.6: Correct Mathematical Formatting

Finally, the Notes application offers the option for users to take on different roles, distinguishing,
if desired, between the role of “Teacher” and “Reviewer” (MENU � Insert � Comment). 
In this way, documents may be developed in a collaborative manner between student peers 
and teachers!

The Notes application offers teachers and students a simple and yet powerful means of 
annotating their mathematical documents to produce, not only a professional appearance, 
but a true record of their mathematical thinking and activities.


